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1.  OVERVIEW

The RabbitCore RCM2000 series is an advanced line of mod-

ules that incorporates the powerful Rabbit 2000 microprocessor,

flash memory, and static RAM, all on a PCB not much larger

than the size of a business card.

The RCM2000 series modules are designed for use on a motherboard that supplies power 

and interfaces with real-world I/O devices. Up to 40 pins of I/O and four serial ports are 

available for system interfacing.

To accommodate a variety of user and production needs, the RCM2000 family includes 

versions with varying amounts of onboard memory. All modules within the family are pin-

for-pin compatible and may be installed or swapped in a matter of minutes.

1.1  RCM2000 Series Description

There are three production models in the RCM2000 series. Their standard features are 

summarized in Table 1.

The RCM2000 is the version that is included in the Development Kit.

Table 1.  RCM2000 Features

Model Features

RCM2000
Full-featured RabbitCore module with 256K flash 

memory and 512K SRAM

RCM2010 RCM2000 with 128K SRAM

RCM2020 RCM2000 with 18.432 MHz clock and 128K SRAM
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1.2  Physical and Electrical Specifications

Table 2 lists the basic specifications for all models in the RCM2000 series.

NOTE: For complete product specifications, see Appendix A in the RabbitCore 

RCM2000 User’s Manual.

The RCM2000 series modules have two 40-pin headers to which cables can be connected, 

or which can be plugged into matching sockets on a production device. The pinouts for 

these connectors are shown in Figure 1 below.

Figure 1.  RCM2000 Connector Pinout

Table 2.  RCM2000 Specifications

Specification Data

Power Supply 4.75 – 5.25 V DC (120 mA at 25.8048 MHz clock speed)

Size 1.90 × 2.30 × 0.55 inches (48.3 × 58.4 × 14 mm)

Environmental –40°C to 70°C, 5–95% humidity, noncondensing
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1.3  Development Software

The RCM2000 series of modules uses the Dynamic C development environment for rapid 

creation and debugging of runtime applications. Dynamic C provides a complete develop-

ment environment with integrated editor, compiler and source-level debugger. It interfaces 

directly with the target system, eliminating the need for complex and unreliable in-circuit 

emulators.

Dynamic C must be installed on a Windows workstation with at least one free serial 

(COM) port for communication with the target system. See Chapter 3., “Installing 

Dynamic C,” for complete information on installing Dynamic C.
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1.4  How to Use This Manual

This Getting Started manual is intended to give users a quick but solid start with the 

RCM2000 series modules. It does not contain detailed information on the module hard-

ware capabilities or the Dynamic C development environment. Most users will want more 

detailed information on some or all of these topics in order to put the RCM2000 to effec-

tive use.

1.4.1  Additional Product Information

Detailed information about the RabbitCore RCM2100 series is provided in the Rabbit-

Core RCM2000 User’s Manual, which is available on the accompanying CD-ROM in 

both HTML and Adobe PDF format.

Some advanced users may choose to skip the rest of this introductory manual and proceed 

directly with the detailed hardware and software information in the User’s Manual.

TIP: We recommend that anyone not thoroughly familiar with Z-World controllers at 

least read through the rest of this manual to gain the necessary familiarity to make use 

of the more advanced information.

1.4.2  Additional Reference Information

In addition to the product-specific information contained in the RabbitCore RCM2000 

User’s Manual, several higher level reference manuals are provided in HTML and PDF 

form on the accompanying CD-ROM. Advanced users will find these references valuable 

in developing systems based on the RCM2100 series modules:

• Dynamic C User’s Manual

• Rabbit 2000 Microprocessor User’s Manual
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1.4.3  Using Online Documentation

We provide the bulk of our user and reference documentation in two electronic formats, 

HTML and Adobe PDF. We do this for several reasons.

We believe that providing all users with our complete library of product and reference 

manuals is a useful convenience. However, printed manuals are expensive to print, stock, 

and ship. Rather than include and charge for manuals that every user may not want, or pro-

vide only product-specific manuals, we chose to provide our complete documentation and 

reference library in electronic form with every Development Kit and with our Dynamic C 

development environment.

Finding Online Documents

The online documentation is installed along with Dynamic C, and an icon for the docu-

mentation menu is placed on the workstation’s desktop. Double-click this icon to reach the 

menu. If the icon is missing, create a new desktop icon that points to default.htm in the 

docs folder, found in the Dynamic C installation folder.

The latest versions of all documents are always available for free, unregistered download 

from our Web sites as well.

Printing Electronic Manuals

We recognize that many users prefer printed manuals for some uses. Users can easily print 

all or parts of those manuals provided in electronic form. The following guidelines may be 

helpful:

• Print from the Adobe PDF versions of the files, not the HTML versions.

NOTE: The most current version of Adobe Acrobat Reader can always be downloaded 

from Adobe’s web site at http://www.adobe.com. We recommend that you use ver-

sion 4.0 or later.

• Print only the sections you will need to refer to often.

• Print manuals overnight, when appropriate, to keep from tying up shared resources dur-

ing the work day.

• If your printer supports duplex printing, print pages double-sided to save paper and 

increase convenience.

NOTE: If you do not have a suitable printer or do not want to print the manual yourself, 

most retail copy shops (e.g., Kinkos, AlphaGraphics, etc.) will print the manual from the 

PDF file and bind it for a reasonable charge—about what we would have to charge for a 

printed and bound manual.
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2.  HARDWARE SETUP

This chapter describes the RCM2000 hardware in more detail,

and explains how to set up the accompanying Prototyping

Board.

NOTE: This chapter (and this manual) assume that you have the RabbitCore RCM2000 

Development Kit. If you purchased an RCM2000 series module by itself, you will have 

to adapt the information in this chapter and elsewhere to your test and development 

setup.

2.1  Development Kit Contents

The RCM2000 series Development Kit contains the following items:

• RCM2020 module with 256K flash memory and 128K SRAM.

• RCM2000 Prototyping Board with accessory hardware and components.

• Wall transformer power supply, 12 V DC, 500 mA (included only with Development 

Kits sold for the North American market. Overseas users will need a power supply 

compatible with their local mains power).

• 10-pin header to DE9 programming cable with integrated level-matching circuitry.

• Dynamic C CD-ROM, with complete product documentation on disk.

• This Getting Started manual.

• Registration card.
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2.2  Overview of the Prototyping Board

The Prototyping Board included in the Development Kit makes it easy to connect an 

RCM2000 module to a power supply and a PC workstation for development. It also pro-

vides an array of basic I/O peripherals (switches and LEDs), as well as a prototyping area 

for more advanced hardware development.

For the most basic level of evaluation and development, the Prototyping Board can be 

used without modification.

As you progress to more sophisticated experimentation and hardware development, modi-

fications and additions can be made to the board without modifying or damaging the 

RCM2000 itself.

The Prototyping Board is shown in Figure 2 below, with its main features identified.

Figure 2.  RCM2000 Prototyping Board
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2.3  Connections

1. Attach RCM2000 to Prototyping Board

Turn the RCM2000 so that the Rabbit 2000 microprocessor is facing as shown below. Plug 

RCM2000 Headers J1 and J2 into the sockets of headers J1 and J3 on the Prototyping Board.

Figure 3.  Attaching RCM2000 to Prototyping Board

NOTE: It is important that you line up the pins on the RCM2000 headers J1 and J2 

exactly with the corresponding pins of headers J1 and J3 on the Prototyping Board. The 

header pins may become bent or damaged if the pin alignment is offset, and the 

RCM2000 will not work.
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2. Connect RCM2000 to PC

Connect the 10-pin connector of the programming cable labeled PROG to header J3 on the 

RCM2000 module as shown in Figure 4 below. Be sure to orient the red edge of the cable 

towards pin 1 of the connector. (Do not use the DIAG connector, which is used for a normal 

serial connection.)

Figure 4.  RCM2000 Power and Programming Connections

3. Power Supply Connections

Hook up the connector from the wall transformer to header J5 on the Prototyping Board as 

shown above. The orientation of this connector is not important since the VIN (positive) 

voltage is the middle pin, and GND is available on both ends of the three-pin header J5.

Plug in the wall transformer. The power LED on the Prototyping Board should light up. 

The RCM2000 and the Prototyping Board are now ready to be used.

NOTE: A RESET button is provided on the Prototyping Board to allow a hardware reset.
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2.4  Where Do I Go From Here?

We recommend that you proceed to the next chapter and install Dynamic C (if you do not 

already have it installed), then run the first sample program to verify that the RCM2000 

and the Prototyping Board are set up and functioning correctly.

If everything appears to be working, we recommend the following sequence of action:

1. Run all of the sample programs described in Chapter 4 to get a basic familiarity with 

Dynamic C and the RCM2000’s capabilities.

2. For further development, refer to the RabbitCore RCM2000 User’s Manual for details 

of the module’s hardware and software components.

A documentation icon should have been installed on your workstation’s desktop; click 

on it to reach the documentation menu. You can create a new desktop icon that points to 

default.htm in the docs folder in the Dynamic C installation folder.

3. For advanced development topics, refer to the Dynamic C User’s Manual, also in the 

online documentation set.

2.4.1  Technical Support

NOTE: If you purchased your RCM2000 through a distributor or through a Z-World or 

Rabbit Semiconductor partner, contact the distributor or partner first for technical support.

If there are any problems at this point:

• Check the Z-World/Rabbit Semiconductor Technical Bulletin Board at 

www.zworld.com/support/bb/.

• Use the Technical Support e-mail form at www.zworld.com/support/support_submit.html.
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3.  INSTALLING DYNAMIC C

To develop and debug programs for the RCM2000 series (and

for all other Z-World and Rabbit Semiconductor hardware), you

must install and use Dynamic C. This chapter takes you through

the installation of Dynamic C, and then provides a tour of its

major features with respect to the RCM2000 series.

3.1  An Overview of Dynamic C

Dynamic C integrates the following development functions into one program:

• Editing

• Compiling

• Linking

• Loading

• Debugging

In fact, compiling, linking and loading are one function. Dynamic C does not use an In-

Circuit Emulator; programs being developed are downloaded to and executed from the 

“target” system via an enhanced serial-port connection. Program development and debug-

ging take place seamlessly across this connection, greatly speeding system development.

Other features of Dynamic C include:

• Dynamic C has an easy-to-use built-in text editor. Programs can be executed and 

debugged interactively at the source-code or machine-code level. Pull-down menus and 

keyboard shortcuts for most commands make Dynamic C easy to use.

• Dynamic C also supports assembly language programming. It is not necessary to leave 

C or the development system to write assembly language code. C and assembly lan-

guage may be mixed together.

• Debugging under Dynamic C includes the ability to use printf commands, watch 

expressions, breakpoints and other advanced debugging features. Watch expressions 

can be used to compute C expressions involving the target’s program variables or func-

tions. Watch expressions can be evaluated while stopped at a breakpoint or while the 

target is running its program.
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• Dynamic C provides extensions to the C language (such as shared and protected vari-

ables, costatements and cofunctions) that support real-world embedded system devel-

opment. Interrupt service routines may be written in C. Dynamic C supports 

cooperative and preemptive multi-tasking.

• Dynamic C comes with many function libraries, all in source code. These libraries sup-

port real-time programming, machine level I/O, and provide standard string and math 

functions.

• Dynamic C compiles directly to memory. Functions and libraries are compiled and 

linked and downloaded on-the-fly. On a fast PC, Dynamic C can load 30,000 bytes of 

code in 5 seconds at a baud rate of 115,200 bps.

3.2  System Requirements

To install and run Dynamic C, your system must be running one of the following operating 

systems:

• Windows 95

• Windows 98

• Windows NT

• Windows Me

• Windows 2000

3.2.1  Hardware Requirements

The PC on which you install Dynamic C for development of RCM2000-based systems 

should have the following hardware:

• A Pentium or later microprocessor

• 32 MB of RAM

• At least 40 MB of free hard drive space

• At least one free COM (serial) port for communication with the target systems

• A CD-ROM drive (for software installation)
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3.3  Installing Dynamic C

Insert the Dynamic C CD-ROM in the drive on your PC. If autorun is enabled, the CD 

installation will begin automatically.

If autorun is disabled or the installation otherwise does not start, use the Windows 

Start > Run menu or Windows Disk Explorer to launch SETUP.EXE from the root folder 

of the CD-ROM.

The installation program will guide you through the installation process. Most steps of the 

process are self-explanatory and not covered in this section. Selected steps that may be 

confusing to some users are outlined below. (Some of the installation utility screens may 

vary slightly from those shown.)

3.3.1  Program & Documentation File Location

Dynamic C’s application, library and documentation files can be installed in any conve-

nient location on your workstation’s hard drives.

The default location, as shown in the example above, is in a folder named for the version 

of Dynamic C, placed in the root folder of the C: drive. If this location is not suitable, enter 

a different root path before clicking Next >. Files are placed in the specified folder, so do 

not set this location to a drive’s root directory.



16 RabbitCore RCM2000

3.3.2  Installation Type

Dynamic C has two components that can be installed together or separately. One compo-

nent is Dynamic C itself, with the development environment, support files and libraries. 

The other component is the documentation library in HTML and PDF formats, which may 

be left uninstalled to save hard drive space or installed elsewhere (on a separate or net-

work drive, for example).

The installation type is selected in the installation menu shown above. The options are:

• Typical Installation — Both Dynamic C and the documentation library will be installed 

in the specified folder (default).

• Compact Installation — Only Dynamic C will be installed.

• Custom Installation — You will be allowed to choose which components are installed. This 

choice is useful to install or reinstall just the documentation.
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3.3.3  Select COM Port

Dynamic C uses a COM (serial) port to communicate with the target development system. 

The installation allows you to choose the COM port that will be used.

The default selection, as shown in the example above, is COM1. You may select any avail-

able port for Dynamic C’s use. If you are not certain which port is available, select COM1. 

This selection can be changed later within Dynamic C.

NOTE: The installation utility does not check the selected COM port in any way. Speci-

fying a port in use by another device (mouse, modem, etc.) may cause temporary prob-

lems when Dynamic C is started.

3.3.4  Desktop Icons

Once your installation is complete, you will have up to three icons on your PC desktop, as 

shown below.

One icon is for Dynamic C, one opens the documentation menu, and the third is for the 

Rabbit Field Utility, a tool used to download precompiled software to a target system.
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3.4  Starting Dynamic C

Once the RCM2000 module is set up and connected as described in Chapter 2 and 

Dynamic C has been installed, start Dynamic C by double-clicking on the Dynamic C 

icon. Dynamic C should start, then look for the target system on the COM port you speci-

fied during installation (by default, COM1). Once detected, Dynamic C should go through 

a sequence of steps to cold-boot the module and compile the BIOS.

If you receive the message beginning “BIOS successfully compiled …” you are ready to 

continue with the sample programs in the next chapter.

3.4.1  Communication Error Messages

If you receive the message “No Rabbit Processor Detected,” the programming cable may 

be connected to a different COM port, a connection may be faulty, or the target system 

may not be powered up. First, check to see that the power LED on the Prototyping Board 

is lit. If it is, check both ends of the programming cable to ensure that it is firmly plugged 

into the PC and the RCM2000’s programming port. If you are using the Prototyping 

Board, ensure that the module is firmly and correctly installed in its connectors.

If there are no faults with the hardware, select a different COM port within Dynamic C. 

From the Options menu, select Project Options, then select Communications. The 

dialog shown should appear.

Select another COM port from the list, then click OK. Press <Ctrl-Y> to force Dynamic C to recom-

pile the BIOS. If Dynamic C still reports it is unable to locate the target system, repeat the above 

steps until you locate the active COM port.

If Dynamic C appears to compile the BIOS successfully, but you then receive a communi-

cation error message, it is possible that your PC cannot handle the 115,200 bps baud rate. 

Try changing the baud rate to 57,600 bps as follows.

• Locate the Serial Options dialog in the Dynamic C Options > Project Options > 

Communications menu. Change the baud rate to 57,600 bps.
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If you are using Dynamic C version 7.04 or earlier, modify the BIOS source code as fol-

lows. Skip these three steps if your version of Dynamic C is 7.05 or later.

1. Open the BIOS source code file named RABBITBIOS.C, which can be found in the 

BIOS directory.

2. Change the line

#define USE115KBAUD 1 // set to 0 to use 57600 baud

to read as follows.

#define USE115KBAUD 0 // set to 0 to use 57600 baud

3. Save the changes using File > Save.

Now press <Ctrl-Y>. You should receive the “BIOS successfully compiled …” message 

indicating that the target is now ready to compile a program. You should then continue with 

the sample programs in the next chapter.
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4.  SAMPLE PROGRAMS

To help familiarize you with the RCM2000 modules, several

sample Dynamic C programs have been included. Loading, exe-

cuting and studying these programs will give you a solid hands-

on overview of the RCM2000’s capabilities, as well as a quick

start with Dynamic C as an application development tool.

4.1  Sample Program Overview

Dynamic C comes with a large number of sample programs that illustrate many of its fea-

tures. These programs are intended to serve as tutorials, but then can also be used as start-

ing points or building blocks for your own applications.

NOTE: It is assumed in this section that you have at least an elementary grasp of ANSI C. 

If you do not, see the introductory pages of the Dynamic C User’s Manual for a sug-

gested reading list.

Sample programs are provided in the Dynamic C Samples folder, which is shown below.
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